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READ ME FIRST

Welcome to Take Control of Fonts in Mac OS X: Tiger Edition,
version 1.0.

This ebook tells you everything you need to know (and then some!)
about fonts on your Mac: what and where they are, how to organize
them, how to access the hidden wealth of characters inside some of
them, and how to use the Mac OS X font tools—Font Book, Keyboard
Viewer, and Character Palette. It demystifies Unicode, shows you how
to deal with old font suitcase files, and explains how to get your font
collection under control.

This ebook was written by Sharon Zardetto Aker, edited by Tonya
Engst, and published by TidBITS Electronic Publishing.

To get in touch or learn more about the Take Control ebooks, you can:

• Contact us by sending email to tc-comments@tidbits.com.

• See About This Ebook to learn about the author and publisher.

• Read the fine print on the copyright page.

• Find answers to general questions by reading the FAQ at
http://www.takecontrolbooks.com/faq.html.

• Buy another ebook by checking out our Featured Titles or by
visiting http://www.takecontrolbooks.com/catalog.html.

The price of this ebook is $20. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend button on the cover makes it easy for you to give your friend
a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.
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Onscreen Reading Tips
We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:

• Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

• Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.

• After following a link, you can easily return to the previous
location in your document. This table summarizes the necessary
menu commands and keyboard shortcuts:

How to Quickly Navigate to a Previous Point in This Ebook

Software Menu Command Keyboard Shortcut

Adobe Acrobat 6 View > Go To > Previous View Command-Left arrow

Adobe Acrobat 5 Document > Go To > Previous
View

Command-Left arrow

Preview Go > Back Command-[

• In Adobe Acrobat Pro version 6 or 7, set your preferences to view
Web URLs in a Web browser: choose Acrobat > Preferences, switch
to the Web Capture pane, and choose In Web Browser from the
Open Web Links pop-up menu.

• Find more tips in the Take Control FAQ on the Web.

Printing Tips
Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

• Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.
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• Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates. The
link must be accessed from the cover of your PDF.

• For a tighter layout that uses fewer pages, check your printer
options for a 2-up feature that prints two pages on one piece of
paper. For instance, your Print dialog may have an unlabeled pop-
up menu that offers a Layout option; choose Layout, and then
choose 2 from the Pages per Sheet pop-up menu. You may also
wish to choose Single Hairline from the Border menu.

• When printing on a color inkjet printer, to avoid using a lot
of color ink (primarily on the yellow boxes we use for tips and
figures), look for an option to print entirely in black-and-white.
(However, unlike many Take Control ebooks, this particular ebook
uses color in some tables and illustrations to provide additional
clarity. If you are printing an excerpt from the “Organize Your
Fonts” section, we recommend color printing, if you have the
option, though black-and-white will do the job.)

• In the unlikely event that Adobe Acrobat or Adobe Reader cannot
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics
When reading this ebook, you may get stuck if you don’t know certain
basic procedures or don’t understand Take Control syntax for things
like working with menus or finding items in the Finder. Please note
the following:

• Path names: The route you take to a file on your hard drive,
whether by looking through columns in a window or by double-
clicking your way through folders, is the file’s path.

The syntax for paths conforms to Unix standards, because that’s
what underlies Mac OS X. The disk’s name is always the first thing
in an actual path; since we can assume that the disk is always
there, we don’t include its name in the path—but we preserve the
slash that would separate it from the next item. So, HardDrive/
System/Library/Fonts becomes /System/Library/Fonts.
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A path to something in a user’s home directory starts with the
drive’s name, followed by Users and then the user’s name. The
handy convention, however, is to replace those first three items
with ~ (tilde), so HardDrive/Users/Jerry/Library/Fonts
becomes simply ~/Library/Fonts. (You’ve probably noticed by
now that path text is formatted in special type.)

For something a little further down, or back up, in a path that was
just described, or if the beginning of the path is unknown (because,
for instance, it varies from one user to another), we use two
periods to indicate the missing part of the path: “With Creative
Suite, you get /Library/Application Support/Adobe/
Fonts, and its subfolder, ../Adobe/Fonts/Reqrd/Base.”

• Menus: To describe choosing a command from a menu in the
menu bar, this ebook uses an abbreviated description like Edit >
Resolve Duplicates. When the actual command name changes
based on a special situation or selection, there’s a generic
reference: if the command would be File > Remove “NewFlier”
based on the name of the selection, the description is File >
Remove CollectionName.

• System Preferences: Working with certain aspects of fonts
means some trips to System Preferences. To get there, choose
System Preferences from the Apple menu. Each icon in the
Preferences window opens a pane of information. So, if I say
“In the International pane of System Preferences” or “in the
International preference pane,” you’ll know you have to choose
Apple > System Preferences and click on the International icon.
Some panes have multiple screens, accessed by clicking their tabs
(titles) in the pane, so the directions might say “…in the Input
Menu tab of the International pane…”.
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Assumptions
Yes, I know what they say about “assume” but I’m going to anyway.
As long as you know what the assumptions are, we can prevent some
misunderstandings:

• You’re working in Tiger: Font management in Mac OS X
changed drastically from one release to the next; little of this ebook
applies to versions before Jaguar, and Font Book changed
immensely just for Tiger.

• You’re working in at least 10.4.3: I was working in 10.4.6
by the time this ebook went “to press,” but 10.4.3 especially fixed
some specific problems in Font Book (enough that I had to delete
some complaints). There’s no excuse not to stay current on free
system updates, so get with it!

• You have administrative access to your Mac: I do mention,
in a few places, the difference having access (or not) might mean
to a font situation, but the general assumption is that you’re in
charge. (If you’re uncomfortable with, or confused by the very idea
of “administrative access,” Appendix F: Users and Accounts can
ease your mind.)

• You’re not using third-party font management software:
Wherever I discuss Font Book and its use, I proceed with the
assumption that Font Book is your font management software.
You can’t have more than one of these utilities running at a time,
so if you’re working with a third-party solution but want to try
(or go back to) Font Book, disable the third-party manager.

• You have Microsoft Office 2004 and/or Adobe Creative
Suite: (CS1 or 2, or a standalone InDesign). That’s not to say
that you need any of these programs to use the information in this
ebook or that if you use QuarkXpress this ebook won’t help you. It
is merely that I generally use Adobe InDesign and Microsoft Word
as the non-Apple standards of how fonts are handled in Mac OS X;
they work very well as the extremes of the sublime-to-ridiculous
range. And, because they are so popular, font problems specific
to those application suites are included in the troubleshooting
section. When it comes to the “Organize Your Fonts” segment,
I take into account that you may have Apple’s iLife or iWork and
the fonts that they donate to your system.
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INTRODUCTION

It’s utterly astonishing that a computer platform whose initial claim
to fame was not just its interface but its use of different fonts could
celebrate its almost-20th anniversary with a new operating system
that totally ignored the importance of fonts, pretending that the
difficulty—or total inability—to install and manage fonts didn’t
matter.

As a Mac fanatic from way back (1984, to be precise), I hate to admit
that it took Mac OS X years to get its act together concerning fonts,
and that I also totally ignored the issue as long as I could. I know I felt
frustrated; I think I also felt insulted.

But Mac OS X has its act together now, even if it’s not entirely
polished. With the release of Tiger, fonts became manageable
(literally, with Font Book 2.0), and their Unicode-inspired wealth
of characters and advanced typographical features became more
accessible. Every Tiger upgrade improves the situation a little more,
with tiny, usually unannounced, changes to Font Book and general
font-handling issues. So now we can quit whining about how bad
it was and look at how good it is.

You’ll find all the basics of font management in this ebook: what font
types are supported in Mac OS X, installation, removal, verification
of font file integrity, and the Font Book how-to (and why). You’ll get
the background details you need about Unicode and its ripple effect
on almost every font-related thing you do, why document exchanges
cause font problems, and how to access foreign- language characters
and keyboards. You’ll also find information you didn’t know you
needed, such as how to find a font in a menu, where to find elusive
characters hiding in so many fonts, and how to pack a suitcase (of
fonts, that is).

While I touch upon font problems in PDFs and on Web pages, you
won’t find enough information to, say, start creating trouble-free,
perfectly encoded Web pages; that’s a topic for some other author.
And, due to space constraints and timeliness, I don’t review font
management software or round up the dozens of font-related share-
ware utilities; instead, I discuss what to look for in font management
beyond Font Book, and I highlight a few especially good shareware
utilities in context of related topics.

This is a free sample of “Take Control of Fonts in Mac OS X.”
Click here to buy the full 255-page ebook for only $20!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU04225830955&PT=TRK-0036-SAMPLE


Page 8

As for serious troubleshooting: my collection of specific font problems
and solutions grew so much as I wrote this ebook that they became
a companion volume, Take Control of Font Problems in Mac OS X:
Tiger Edition, which includes not only dealing with some very specific
problems (such as your font icons going wonky or Font Book repeat-
edly quitting), but also how to perform basic and special trouble-
shooting procedures (such as safe booting, repairing permissions,
and setting up a separate user account for testing purposes).

TIP TROUBLESHOOT PESKY FONT PROBLEMS AND SAVE $5
To save $5 on the purchase of Take Control of Font Problems in
Mac OS X, click the URL below to open a catalog page about the
ebook. If you choose to purchase, a $5-off coupon should appear
at the upper right of the first screen of the shopping cart.
http://www.takecontrolbooks.com/font-problems-macosx.html

The main mission of the this ebook is self-evident, but there are two
minor ones I’d also like to accomplish: to pique your interest regard-
ing characters buried in many common fonts and to help you achieve
a certain comfort level in dealing with Unicode and glyph IDs for char-
acters. To kill both those birds with one stone (and use an awkward
metaphor at the same time), where parts of figures need emphasis,
I’ve used characters from different fonts to point, circle, label, or
otherwise command your attention. In the figure margin, I identify
the character by its font and Unicode or glyph ID (or both). It looks
something like this figure, though much more sensible and sedate.

FIGURE

Jagged arrow:
Apple Symbols

U+2189

Dashed arrow:
Sand U+2198,

GID 350

Circled letters:
MS PGothic
starting at

U+24D0
GID 17543

This
combination
of arrows
and letters
is just for
fun.
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QUICK START

The material in this ebook is presented with the mild assumption that
you’ll read it linearly, but that doesn’t mean that you have to read it
that way. You could, instead, start with font installation techniques,
or troubleshooting procedures, or why you can’t seamlessly share
documents with a PC user.

Beginning at the beginning:

• Whether you’re a font minimalist with nary a problem or a font
fanatic with nothing but, covering the basics is a good place to
start. Check out the Supported Font Types, and the oh-so-many
places you can store them, in Mac OS X Fonts folders.

• Explore the Unicode Universe, discover the wealth of characters
stored in fonts with The joy of character-rich fonts, get up to speed
with the latest font buzzword (and important concepts) in The
world according to glyphs, and learn how to Utilize Smart-Font
Typography.

• Whether your font collection is a mess or merely a nightmare
waiting to happen, get things in order with Organize Your Fonts,
and keep them that way with Stay Organized.

Installing and managing fonts:

• If you’d like just a minimum introduction to Font Book, jump
to Tour the Interface; if you’d like more than a passing familiarity
with this invaluable utility, read Get Acquainted with Font Book.
For details on specific functions, check out Validate Fonts, Disable
(and Enable) Fonts, Create and Edit Collections, and Use Libraries
to Control Your Fonts.

• To learn about installing all types of fonts, with and without Font
Book, see Install New Fonts and, of course, Remove Fonts You
Don’t Want. To keep track of all the additions to your collection,
use the tricks in Font-tracking techniques.

• Are duplicates driving you crazy? Deal with Duplicates covers both
general and Font Book issues in that area. And if you think that
duplicates are… well, duplicates, jump directly to All Duplicates
Are Not Created Equal.
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• Old fonts? Update Legacy Fonts helps you make use of (most of)
them. Old applications? If you still use Classic applications, you
can find special advice in Control Your Classic Fonts.

Working with fonts and typing special characters:

• Font menus, never as straightforward as they seemed, have a few
added wrinkles in OS X; iron them out with Master Font Menus
and Font Formatting.

• As for typing any of the thousands of special characters available
in some fonts, start with a survey of “input methods” in Turn On
the Tools. If you need to type accented characters, check out Use
Keyboard Viewer to Type Accented Characters and Type more
accents with the U.S. Extended Keyboard. To learn how to enter
(and find!) the zillion other characters in modern fonts, read Find
and Enter Characters with Character Palette.

• If you want to type entirely in another language, or in a different
“system,” like the Dvorak method, read Use Alternate Keyboards
for Foreign Languages or Other Special Input.

Going beyond your Mac:

• There’s only one sure way to keep fonts in your documents from
transmogrifying, and that’s to never let them leave your Mac. But
when you have to let go, you should know How to Synchronize
with the Rest of the World, and especially How to Minimize
Document-Exchange Problems.

This is a free sample of “Take Control of Fonts in Mac OS X.”
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LEARN FONT BASICS

We’ve come a long way from the bitmapped fonts on the original Mac,
which were a miracle in the days of the blocky, one-size-fits-all text
on other computers. Along that long way, new font technologies have
been developed, praised, accepted as a standard, and then nudged
aside by the next new thing.

I’ve broken the topic of learning font basics into three sections. You
need to understand them all before you can really wrangle your fonts:

• Supported font types: Some fonts are new to Mac OS X, others
are on their way out (I cover these below).

• Font locations: Read Where Tiger Stores Fonts. Be sure to read
the entire section since the last topic, The font access order, is
especially important to understand.

• Unicode: You might be tempted to skip my short treatise, Explore
the Unicode Universe, but I’m warning you: you’ll have to come
back to it sooner or later!

Supported Font Types
Mac OS X supports an amazingly wide variety of fonts. Here’s the
cast, in order of appearance on the computer scene:

• PostScript Type 1 and companion bitmapped suitcases (details
begin just ahead)

• TrueType (Mac)

• TrueType (Windows)

• Multiple Master instances

• OpenType

• dfont

You can find details on all the font types in this section, and see a
roundup of all the font specifications in Appendix A: Font Specs.
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ORGANIZE YOUR FONTS

Are you just beginning your Mac OS X font experience and have
no idea where to start? Are you drowning in extra fonts that you’ve
installed in various places and have no idea how get out from under
the mess you now have on your hands?

No matter where you fall on the font-muddle spectrum, the guidelines
and step-by-step procedures in this section get you back on track—
and keep you there. I’ll show you how to:

• Get organized: Clean up your current Fonts folders: add missing
fonts, delete duplicates, and generally sift through what might
already be an out-of-control font collection.

• Back up the clean setup: Just in case things go kerflooey later
(see Make Backup Archives).

• Stay organized: Use subfolders and other methods of tracking
old and new fonts (see Stay Organized).

Clean Up the Fonts Folders
There’s more to organizing your fonts than just dragging them to the
right locations—although that’s an important part of it. Cleaning up
your three basic Fonts folders—System, User, and Library—is a sim-
ple, but multi-step, process. Before we get started, here’s a quick
overview of what you’ll do:

1. Restore the folder to the way Tiger meant it to be: We’ll
reinstate missing fonts and offload nonmembers. If you’ve
removed fonts and don’t want them back, that’s okay—but you can
get them back if you’ve changed your mind. In the sections to
follow, we’ll clean up these folders:

• System Fonts (/System/Library/Fonts): Tiger installs 30
font files in this folder.

• Library Fonts (/Library/Fonts): Tiger installs 35 font files
here, and iLife and iWork add their fonts to this folder, too.

• User Fonts (~/Library/Fonts): Tiger doesn’t install any
fonts in this folder, but Microsoft Office does; Office X puts in
about 15, but Office 2004 donates a generous 77 items. If you’ve
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GET ACQUAINTED WITH FONT BOOK

Font Book is Tiger’s font-management utility. Its obvious raison
d’être is to install and remove fonts without your having to run
around to all the Fonts folders. But it does more than just installation
chores: it checks fonts for corruption, indicates and resolves
duplicates, displays a font’s complete character set, copies designated
fonts into a separate folder to accompany your document to a printer,
and generally helps you wade through the hundreds of fonts you’ll
have just by installing a Microsoft or Adobe application or two.

To do anything beyond blindly installing a font, you need to know at
least the basics of Font Book; that’s covered in Tour the Interface,
below.

To really take control of your fonts, and to make the most of Font
Book’s features, you’ll eventually need to learn more about its general
capabilities. Learn Font Book’s Search Function and The Finer Points
of Using Font Book follow the interface tour; they aren’t immediately
necessary, but they’ll help you work more efficiently. I cover other
Font Book capabilities later in related topics, such as Disable (and
Enable) Fonts, Use Font Book to Handle Duplicates, Create and Edit
Collections, and Use Libraries to Control Your Fonts.

Tour the Interface
It’s easy to get started in Font Book, because its surface behavior
and interface (Figure 3) are predictable. But that friendly surface
belies both its versatility and its—let’s be kind and call it quirkiness—
in some behaviors and interface elements.

Font Book is in your Applications folder, and opens automatically
when you double-click on (the right kind of) font file; if you do a lot
of font wrangling, keep it in your Dock for easy access.
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INSTALL NEW FONTS

Install what fonts? From where? Some users are drowning in
unwanted fonts; others just can’t get enough. If you’re in the market,
you don’t have to spend a cent to add to your font collection.

You may be disappointed that I’ve squeezed information about find-
ing free fonts down to this little segment. But it’s much worse for me:
no more “But I’m working. No, really!” excuse for whiling away a few
hours perusing the beauty of zillions of typefaces. But, after all, let’s
face it: you don’t need an ebook to help you find fonts the way you
would have before the Web—you can just search in Google for “free
fonts” to find lots of offerings.

Many free-font sites are eyesores, with blinking banners and obnox-
iously intrusive ads; lots of the hits you’ll get on a Google search are
sites that simply list other font sites (including those that list other
sites that list…). In order for my countless hours of research not to go
to waste (and to save you some trolling time), I offer my top ten list—
in no particular order—wherein I’ve forgiven an annoying ad or two
that doesn’t otherwise interfere with the overall interface:

• http://www.fontica.com/ • http://www.dingbatpages.com/

• http://www.dafont.com/ • http://www.eternalfonts.com/

• http://www.fontfile.com/ • http://www.fontgarden.com/

• http://www.highfonts.com/ • http://www.1001fonts.com/

• http://www.simplythebest.net/fonts/

• http://www.bancomicsans.com/fonts.html

If you’re going to buy fonts, here are some guidelines to keep in mind:

• Watch out for the font count: The banner screams Only $7.00
per font! so you choose four, and your total comes to… $126?
Three of those “fonts” had the standard four typefaces, and one of
them had six, so you actually bought 18 “fonts.” It all depends how
you define font, and by traditional standards, a typeface is a font
(see the sidebar Fonts, Families, and Faces). Seven dollars per font
family, now that’s a bargain. Shame on the font vendors who don’t
make that clear for the less savvy customers, but they’re not doing
anything illegal.
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VALIDATE FONTS

Corrupted font files are an old, familiar problem to Mac users. They
were corruptible because they were “writeable”—the system opened
the files not just for use but also to change ID numbers in an effort
to avoid conflicting IDs. That approach has, fortunately, fallen by
the Mac OS X wayside, with font files strictly read-only now. Most
font corruption reported under Mac OS X is either of old files, or
a false report due to corruption in a font cache file. (I describe font
caches in Delete the System Font Caches, located in Excerpt 2 near
the end of this ebook.)

Validation is simply Font Book’s way of checking font files for internal
problems. It doesn’t fix the problems; it merely reports them to you.

Font Book provides three ways of validating fonts:

• Automatic validation: Triggered when you install a font
through Font Book, which is why installing more than a few fonts
at a time can cause Font Book to seemingly seize up for anywhere
from a half minute to several minutes: you’ll see the “in progress”
gear spinning as Font Book churns away at validating each and
every font you just dragged in from that font CD.

• File > Validate File: For fonts that are not installed; you can
choose a single font file, or an entire folder (which will include its
subfolders in the checkup).

• File > Validate Font: For already-installed fonts; select one or
more in the Font list.

Why would you need either of the “manual” Validate commands,
when there’s automatic validation of fonts on installation? If you
install fonts by dragging them directly into folders, bypassing the
automatic validation, you can check them beforehand with Validate
File, or afterward with Validate Font. Validating in advance saves
time, not so much for the install-and-then-remove a bad font, but
because once the fonts are installed, it’s time-consuming to pick
them out of the Font list for validation. In addition, I’ve found that
the Validate commands sometimes flag a questionable font that
passes the automatic validation procedure.
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REMOVE FONTS YOU DON’T WANT

In this section I discuss the two pressing issues of font removal: how
to remove fonts, and which ones to remove (an art explained in Trim
the Excess Font Fat).

Removing vs. Disabling: When you don’t want to use a font,
and won’t want to use it again in the foreseeable future, you remove
it. When you want it hanging around for easy access or a recurring
project but don’t want it cluttering your Font menus in the mean-
time, you can disable it instead, a topic I cover in Disable (and
Enable) Fonts.

Use Font Book to Remove Fonts
To remove a font, select it in Font Book’s Font list, and press Delete
or choose File > Remove FontName. The font file is (usually) moved
to the Trash, so if you don’t want it erased the next time you empty
the Trash, you have to drag it out and store it someplace. This isn’t so
draconian when you consider that a copy of the font file was placed in
the target folder during installation, with the original left in place; so,
you should already have a copy of any of your user-installed fonts. For
system-installed fonts, you have to be more careful because there’s no
easy way to get fresh copies (see Excerpt 1: Restore or Add Tiger
Fonts for help with that).

I said the font file is “usually” moved to the Trash, because there are
exceptions:

• A system font—one in /System/Library/Fonts—is removed
only from Font Book’s Font list; the font file is not removed from
its folder. (See Remove or Replace System Fonts.)

• If you don’t have administrative privileges, removing something
from the Computer library in Font Book (regardless of whether the
font’s in /System/Library/Fonts or /Library/Fonts)
removes it from the Font list, but the font file remains in its folder.

• A font from a user-defined library remains in its original location—
which seems fair, since a copy of it was never placed in any Fonts
folder in the first place. (See Use Libraries to Control Your Fonts.)
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CONTROL YOUR CLASSIC FONTS

There are only two reasons to install a font in the Classic Fonts
folder (/System Folder/Fonts): you want to use it in a Classic
application, or want it available in both the Classic and Mac OS X
environments. Because this folder is somewhat of a “lowest common
denominator,” early Mac OS X users were often advised to use it
when in doubt about where to put their fonts. But don’t do it unless
you actually work in the Classic environment, and the font is one
that works there.

The two types of fonts you can install into Classic are Mac TrueType
suitcases and PostScript Type 1’s. Since Classic, in its heart, is OS 9, it
can’t use Windows TrueType, OpenType, or dfont fonts, so there’s no
reason to put them there, even though Mac OS X applications can still
access them.

THIRD-PARTY

SOLUTION

USE YOUR DFONTS IN CLASSIC

Do you just love Baskerville or Herculanum, or other system-
supplied dfonts, and want to use them in your Classic environ-
ment, too? There’s not much difference between TrueType and
a dfont, and the freeware dfontifier can change your dfont into
TrueTypes, and vice versa.
http://homepage.mac.com/mdouma46/dfont/dfont.html

(Are you still trudging along in the Classic environment because you
couldn’t upgrade some program you love or QuarkXpress? Prepare
to move on! How long do you think Apple is going to continue sup-
porting the past? The new Intel-based Macs emulate the PowerPC
environment, but they don’t emulate the Classic environment, too.)

Installing a TrueType suitcase or PostScript Type 1 font into the
Classic folder is almost identical to the operations for those fonts
going into other libraries:

1. Quit all the applications running under Classic, or stop the Classic
environment itself.

You can stop Classic through the Classic preference pane in System
Preferences, or with a command in the Classic menu if you’ve put
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DISABLE (AND ENABLE) FONTS

Disabling a font makes it unavailable to applications without your
removing it from a Fonts folder, letting you easily activate it again
if you want to use it. (If you’re never going to use it again, you can
remove it.)

There are three reasons for disabling fonts:

• To shorten Font menus by turning off fonts you don’t use all the
time.

• To force the operating system to use a specific version of a
duplicate font so you can get at its special features or coordinate
with another computer that will be using your document.

• On multi-user Macs, to “get rid of” fonts you don’t use without
actually removing them from a shared Fonts folder, so other users
can still access them. (Fonts are disabled on a per-user basis.)

This section covers the basics of disabling (or deactivating, or
turning off) fonts; I cover duplicate font issues in the next section.

Warning! Do not disable any font that can’t be removed because
the operating system uses it (see The System Fonts folder).

TIP OFFLOAD INSTEAD OF DISABLE

If you keep hundreds of fonts disabled at a time because your
font collection is so vast, and you keep them disabled for long
intervals, you’re better off removing those fonts and putting
them back in when you need them. The more fonts you have,
the longer Font Book takes to open. More importantly, disabled
fonts eat up memory. Off-loading isn’t as time-consuming as
it sounds, since you can keep your fonts in subfolders that can
be dragged in and out of your Fonts folders. (Or, you might find
that libraries serve your situation well: check Use Libraries to
Control Your Fonts.)
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DEAL WITH DUPLICATES

Duplicate fonts are not the bugaboo they were prior to Mac OS X,
causing constant freezes and crashes. On the other hand, their cur-
rent, generally peaceful, coexistence requires a new set of user skills
and knowledge.

Theoretically, the existence of duplicate fonts should make no
difference: the OS grabs the first one in the access order and ignores
the rest. And, of course, you may wonder why it matters at all which
copy of a duplicate is being used: aren’t they, after all… duplicates?

All Duplicates Are Not Created Equal
Font Book and the OS define duplicate fonts as those sharing a
name—which has nothing to do with the filename, but refers to the
real name stored internally in the font file. This less-than-rigorous
definition is the crux of many problems. Ostensible duplicates can be:

• Different types: OpenType, PostScript Type 1, Mac TrueType,
Windows TrueType, dfont—it may not make any difference to you
on your system, but if you’re sharing fonts or documents, you may
have to match the destination’s font-handling capability. Windows
TrueType and dfonts don’t work on pre-Mac OS X Macs; PCs can’t
use Mac TrueTypes; a print shop might be using only PostScript
fonts.

• Different versions: Older versions may not be Unicode-
compliant; newer versions may offer more characters. One
version—not necessarily the newer one—might have more type-
faces than another. And, once again, matching the version of a
font on the destination computer could be an overriding concern.

The Tiger-Microsoft duplicates: The overlap of fonts from
Tiger and Microsoft, detailed in Table 13, is for fonts of different
versions, where one has more characters than the other. Replacing
the Tiger versions with the Microsoft ones won’t cause any
compatibility problems, except for the one described in the note
Keep Tiger Versions for Arabic Web Pages in Safari.

• Different designs: Fonts with the same name but from different
designers or foundries may be noticeably different in some design
factors, which can change the look of your document. Or the
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CREATE AND EDIT COLLECTIONS

A Font Book collection is a group of installed fonts with something
in common. You get to define the commonality: it could be as simple
as Handwriting Fonts, as general as Sans Serif Fonts, or as unique
as Ivory-billed Woodpecker Weekly Newsletter Fonts. The collection
itself is just a list, an arbitrary subset of your installed fonts.

Collections are for convenience in dealing with fonts:

• When considering just what font to use for a project, you can
browse through a subset instead of your entire list.

• You can disable and enable an entire group of fonts at once.

• You can export the collection instead of individually selecting fonts
for an export set.

• In applications that use the Font panel (mostly Apple applications
at this point), a collection serves as a way to winnow the list of
fonts you’re selecting from, making it easier to get to the one you
want. (Font Book collections and Font panel collections are spiri-
tually connected on some higher plane, so creating or editing
collections in one affects the list in the other.)

In the future, when Mac OS X gets its font act together (maybe as Mac
OS XI), a collection could serve as a submenu, making Font menus
more manageable; the otherwise inconvenient Font panel interface
uses this approach, as shown in Figure 29.

Create a Collection
Let’s say that you often create fliers that need a variety of weights and
widths in the type, but you never remember which of your fonts have
condensed faces, which have bolder-than-bold faces, and so on, and
you’re tired of scrolling and clicking your way through your entire
font collection when looking for type ideas.

Here’s how to make a more limited browsing list for a specific style:

1. Click the  button beneath the collection list or choose File > New
Collection (Command-N).

2. Name the new collection Black.
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USE LIBRARIES TO CONTROL YOUR FONTS

Although Mac OS X offers many Fonts folders, you don’t have to
use any of them: you can store your fonts anywhere and make them
available for use by creating libraries in Font Book (a feature new
with Tiger).

The distinction between a library and collection is not always clear to
users, but it’s simple: a collection refers to a subset of your installed
fonts, while the library is a group of installed fonts.

There are many advantages to working with user-defined libraries:

• The fonts are not installed in any Fonts folder; no copies are
made—the originals, still in their original location, are accessed for
use in Font menus and documents.

• When you remove a font from a library, or a library from Font
Book, nothing is moved to the Trash—everything stays right where
it is.

• In case of duplicates, the fonts in a library take precedence over
everything except an application’s Fonts folder, so you can be sure
(okay, most of the time—there’s always the application’s folder)
that the fonts you installed through a library are the ones being
used by your programs.

• You don’t have to make a collection, or a multiple selection from
the Font list, in order to export the fonts you used on a job; if you
have them all in a folder to start with, they’re all ready to be sent
to the other user.

Create a Library for Temporary Fonts
When you need a group of fonts for a short-term project, you don’t
have to clutter your menus with them forever, or go through the
bother of individually removing them a short while after installing
them. Creating a library in Font Book makes installing and removing
groups of fonts a breeze. With the fonts in question in a Desktop
folder named FlierFonts:

1. Choose File > New Library (Command-Option-N).

2. Give the Library a name, such as Flier.
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FIND MISPLACED FONTS

Have you noticed that the Finder’s Spotlight isn’t entirely reliable,
especially when it comes to searching for fonts? It occasionally seems
to peek inside suitcase files, while other times it doesn’t even list a
font whose filename is the search criterion and you’re looking right
at it in an open window! But Spotlight’s performance on font hunts
is superb when you know how to focus the search, and you can choose
to look just in suitcases, or for any type of font whose name you
vaguely recall.

Say you want to install a PostScript Type 1 font and you have a
handful of printer files that you know go together because of their
similar names: LaudaBld, LaudaBldItl, LaudaItl, LaudaNor. You
might not remember that the font is actually Laudatio, but at least
you know it begins with Lauda. The real problem is that you can’t
find a suitcase, in your vast but messy font collection from previous
Mac systems, that has a name anything like LaudaWhatever. You
know, however, that it’s in some multi-family suitcase because you
often combined different bitmapped fonts in a single suitcase. Do
you have to open a bunch of suitcases and check their contents until
you find your font in the haystack? Not at all:

1. Start your search:

• If you have an idea of where the target suitcase is, start in that
folder’s window. Use Command-F to go into Find mode and
select the folder’s name in the window’s header.

• Otherwise, use any open Finder window, or open a new one
(Command-N) and use Command-F to go into Find mode. In
the window’s header, set the search scope to Home, Computer,
or another volume as needed.

2. In the top row of pop-up menus (you won’t be needing the second
row, so you can ignore it or click the  button at its far right):

a. From the first pop-up menu, choose Kind.

b. From the second pop-up menu, choose Others.

c. In the field that appears, start typing Font Suitcase.
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PRINT FONT SAMPLES

Mac OS X provides some built-in AppleScripts that let you do a few
tricks with Font Book. The most useful is a routine that creates a list
of font samples.

You can access Tiger-provided AppleScript routines in two ways:

• From the menu bar: If you haven’t already, you can add the
handy Script menu to the menu bar:

1. Double-click the AppleScript Utility program in
/Applications/AppleScript to open it.

2. Check both Show Script Menu In Menu Bar and Show Library
Scripts.

The little black AppleScript icon appears near the right of
your menu bar, listing all the built-in scripts.

3. Close the utility window.

• From the Finder: Open the folder Library/Scripts, which
is also accessible through its alias, /Applications/
AppleScript/Example Scripts.

Menu/Icon equivalents: A Script menu choice and its sub-choice,
like Finder Scripts > Add to File Names, is the equivalent of opening
the folder Finder Scripts and double-clicking on the icon Add to File
Names. If you are just experimenting with scripts, double-click on
them from the Scripts folder; if you decide to use them on a regular
basis, add the Script menu to your menu bar. Directions in this
ebook assume you have the Script menu turned on.

To print font samples:

1. Open Font Book and select some fonts in the Font list.

Samples are created for selected fonts, so start with a few to see
what they look like before you print samples for all the fonts.
(When you want to print all the fonts, click All Fonts in the
Collection list, tab to the Font list, and choose Edit > Select All).
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UPDATE LEGACY FONTS

If you’re not new to the Mac, you may have a few old font favorites,
or even a vast collection that you have no intention of giving up. But
there are a few things you must do and a few things you should do
to use your old fonts in Mac OS X.

Back in the Day
First, a little stroll down memory lane: Beginning in System 7,
bitmapped and TrueType fonts were stored in the system’s Fonts
folder either as single-font files or grouped in suitcases. The suitcases
frequently held several—or many—different font families, because
the system had a limit to the number of font files that could be open
at one time; stuffing a suitcase was the way to get at lots of fonts with
only one file open. Bitmapped and TrueType fonts were often mixed
in a single suitcase for several reasons: as a side effect of the stuff-the-
suitcase philosophy; for backward compatibility with System 6 that
could use the bitmapped but not the TrueType version; or because
the bitmapped version accompanied the PostScript Type 1 file and
the TrueType version looked better on the screen in some setups.

But Apple has played a joke on us in Mac OS X, because although
most of your old fonts are useable, many of them have to be
manipulated first:

• Mac OS X can’t use a single-font file for either bitmapped or True-
Type; fonts must be in suitcase files, even if the suitcase holds only
a single font. (You can cheat and use some of these fonts: see The
Forbidden Fonts.)

• You should trim down multiple-font suitcases, separating True-
Type from bitmapped, and the bitmapped wheat from the chaff
(the ones you need for PostScript fonts, and the ones you don’t).
See the guidelines in Learn How to Pack a Suitcase for OS X,
following.

The punch line to the joke is that you can’t manipulate suitcase
contents in Mac OS X. Even if you’re in Classic, you can’t open
suitcase files the way you did in OS 9, because Classic is not really
an operating system, it just plays one on your Mac. Manipulation
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MASTER FONT MENUS AND FONT FORMATTING

Just pick a font from a menu and type, right? Not always: font menus
differ from one application or utility to another, not only in the fonts
they list but the order in which they list them. In addition, applying
a character style often interacts with typeface selection.

You’d think locating a font in an alphabetical menu or list would
be easy. And, in fact, if you’re looking for something simple like Arial
or Georgia, it is easy. But sometimes a font may be in an unexpected
location in a menu, or seem to be missing. Or, your font selection
might not format text the way you expect it to. In this section, I pro-
vide the background information you need to understand how font
menus work and solve problems.

What’s a “menu”? For the most part, when I talk about font
“menus,” I really mean anyplace you encounter a list of selectable
fonts: submenus, toolbar menus, the Font panel, and pop-ups in
utilities or dialogs.

Find a Font in a Menu
To find some fonts—even a font with a name seemingly as simple as
Adobe Jenson—you’ll have to get used to how specific applications list
them, or you’ll waste a lot of time hunting for the font you want. Com-
mon programs, and even Apple utilities, take different approaches:

• Font Book lists items alphabetically in its Font list—until you look
past Zapfino and see a second group of alphabetized fonts, starting
with those whose names begin with #, followed by alphabetical
listings of fonts identified by foundry or company: Adobe, Apple,
Monotype, and so on. The Font panel (found in most current Apple
applications, and some others) uses this approach, too.

• Character Palette uses a single, all-encompassing alphabetical list,
with the #-prefixed fonts at the top and the foundry-specific fonts
included in their alphabetical slots.

• Word and InDesign both use initial alphabetical lists followed
by groups of foreign- language fonts. But they don’t agree on the
alphabetization in the main group (the general issue is whether to
include foundry or company names: Adobe Jenson might be listed
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CONTROL CHARACTER ENTRY

Character entry? Isn’t that what we used to call “typing”? Yes, but
how can you “type” characters that may (or may not) be accessible
from your keyboard—assuming you can even find the one you want
out of the many hundreds packed into every font?

Luckily, you don’t have to learn the myriad of text-entry options Mac
OS X provides if you have a few targeted needs. Start with Turn On
the Tools so you have Keyboard Viewer and Character Palette at your
beck and call, and then jump to your particular topic:

• If you can’t remember where basic characters like • ™ © √ ≥ ≠ ¢
are—or if you didn’t know you could easily type them in any
font—read Use Keyboard Viewer to Find Special Characters.

• If you type almost entirely in English but need basic accented
letters so you can meet Chloë at the café for a tête-à-tête mañana,
read Use Keyboard Viewer to Type Accented Letters. If you use less
common accented Roman-based letters, such as l  (I don’t
even know what to call those characters, but you’ll recognize them
if you need them), you’ll find that information there, too.

• When you’re ready to dive into the wealth of characters modern
fonts provide, start with Learn about Characters in Fonts and
The world according to glyphs. With that information under your
belt (or even without it), read Find and Enter Characters with
Character Palette to see how you can get at those characters, since
so many of them can’t be typed. If you have only an idea of the
character you want—a pointing figure, say, or a circled letter—Find
characters with the Search function shows you how to find it.

• If you want to type special ligatures or fractions without using
Character Palette, Utilize Smart-Font Technology shows you
how to do it in amenable programs. And if you’re wondering
what difference ligatures or fancy fractions make, or why there
are special “small caps” characters when you can just create them
with character formatting, read The joy of character-rich fonts.
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SYNCHRONIZE WITH THE REST OF THE WORLD

You take your newborn home from the hospital wrapped in the
21st-century equivalent of swaddling clothes—a car seat. You’re
determined to protect her not just from harm but also from the
slightest distress. And yet, one day—whether it’s day care, a play-
group, or the school bus—there she goes: out in the world and
away from your protective care.

So it is with your documents once they leave the cocooned (relative)
safety of your own computer. Out in the world, they face the on-
slaught of foreign systems and applications that can’t always provide
what you did when they were safe at home: just the right fonts.

Disclaimer: The information in this section does not take into
account copyright issues when discussing exchanging fonts between
platforms or even embedding them in PDF files. We’re all adults
here; you know what you’re not supposed to do.

Supply Fonts When You Can
The only way to be sure that the documents you send to another
machine will use the exact same fonts you did is to send the fonts
along with the document. But not all your fonts will work on other
platforms—even on other, pre-OS X, Macs. Table 17 (next page)
rounds up your options.

Unfortunately, using the same font—even the same file—is still no
guarantee that a Mac-designed document will look the same on a
PC (as I explain next), but it’s the best chance you have of getting
the details across that great divide.

This is a free sample of “Take Control of Fonts in Mac OS X.”
Click here to buy the full 255-page ebook for only $20!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU04225830955&PT=TRK-0036-SAMPLE


Page 223

EXCERPT 1: RESTORE OR ADD TIGER FONTS

This section is excerpted (with some adaptations) from the com-
panion ebook, Take Control of Font Problems in Mac OS X: Tiger
Edition. See the tip on page 8 for more info and a discount.

You can’t really “reinstall” system components like fonts because
the Installer basically does a complete installation sweep when you
run it: you can’t pick out a font, or a subset of fonts, with the excep-
tion of the “Additional Fonts,” the extra foreign language fonts for
the /Library/Fonts folder. (Why can’t you just download fresh
fonts from the Apple Web site? Wrapping them in some sort of Mac
OS X-flavored installer would keep them from being installed by
any unlicensed users.)

Until Apple comes to its senses about this, you have three-and-a-half
basic ways of restoring Tiger-supplied fonts:

• Use your archived copies: Unzip the copy of the Fonts folders
that you made according to the directions in Make Backup
Archives. (You didn’t make them? Read on.)

• Use your install disc: This one counts as the “half” option
because it’s good for only partial restoration of the /System/
Library/Fonts folder or a complete install/restore of the
Additionals—the foreign language fonts—that go into
/Library/Fonts.

• Get replacements from a Mac friend: You’re a licensed user
of the software, so it’s not piracy or trespassing.

• Use the shareware program Pacifist: As described in
Reinstall System Components with Pacifist (immediately
following), this is a great tool for extracting components from
your install disc.
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EXCERPT 2: SOLVING BASIC PROBLEMS

This section is excerpted (with some adaptations) from the com-
panion ebook, Take Control of Font Problems in Mac OS X: Tiger
Edition. See the tip on page 8 for more info and a discount.

Many typical font problems can be solved with the procedures I
describe here: replacing a recently installed (presumably corrupt!)
font, deleting Font Book’s plist, and Delete the System Font Caches.
As for Microsoft Office’s favorite font problem, false corrupted-font
warnings, Delete the MS Office Font Cache describes the almost sure-
fire cure for that.

Worth a shot: Sometimes just restarting your Mac makes
problems go away. You might want to try it before you proceed to
other troubleshooting options.

Replace a Corrupt Font
If your font problems begin soon after you’ve added a new font to
your collection, assume the problem lies with that font. Remove it; if
the problem goes away, you can try reinstalling the font as-is (holding
your breath might or might not help), or get a fresh copy.

Just the memory of a corrupt font can cause problems, so you should
also Delete the System Font Caches after removing the problem font,
before you try the replacement.

Delete Font Book’s plist
A plist is a property list, a file that stores a user’s settings for a
program or utility or a—well, for anything that can have settings. It
serves basically the same function as a pre-Mac OS X preferences file
and, in fact, you’ll usually find plists in folders named Preferences.
Not all plists get heavy use, but Font Book’s does, so it’s quite prone
to corruption.
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APPENDIX A: FONT SPECS

Table 18: Font Specs

Name or
Extension

Description Finder
Kind

Font Book
Kind

Comment

Supported in Mac OS X

Bitmapped suitcase

.bmap or .scr
(optional)

Original Mac
screen font;
companion to
PostScript Type 1

Font
Suitcase

(Companion file
shows as Post-
Script Type 1)

Supported only
as PostScript
Type 1
companion font

PostScript printer font (Type 1)

5-letter family
name plus 3
letters for each
style

Outline font;
needs bitmap
FFIL companion

PostScript
Type 1
outline
font

PostScript
Type 1

Needs
companion
bitmap file

TrueType (Mac)

Font family
name

Single or
multiple
TrueType fonts
in a suitcase file

Font
Suitcase

TrueType

TrueType (Windows)

Font family
name

.ttf or .ttc
extension

Cross-platform Windows
TrueType
font

TrueType

Multiple Master instance

Same as
PostScript
printer font and
suitcase, plus
“MM”

A special
PostScript Type
1 font, editable
in previous
systems

PostScript
Type 1
outline
font

PostScript
Type 1

Basically a Type
1 font; its
companion
suitcase file
also has MM in
its name

(continues)
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APPENDIX B: TIGER FONTS

The three tables in this appendix list the fonts Tiger installs:

• System Fonts folder:

Fonts always installed in /System/Library/Fonts, Table 19 (below)

• Library Fonts folder:
Basic fonts always installed in /Library/Fonts, Table 20

• Library Fonts folder:
Additional fonts installed as an option in /Library/Fonts, Table 21

Table 19: Basic Tiger Fonts in the System Fonts Folder

Font File
Language/
Script Font File

Language/
Script

AppleGothic.dfont Korean Hiragino Mincho Pro W6.otf Japanese

AquaKanaBold.otf Japanese Keyboard.dfont

AquaKanaRegular.otf Japanese LastResort.dfont

Courier.dfont LiHei Pro.ttf Chinese

Geeza Pro Bold.ttf Arabic LucidaGrande.dfont

Geeza Pro.ttf Arabic Monaco.dfont

Geneva.dfont Osaka.dfont Japanese

Hei.dfont Chinese OsakaMono.dfont Japanese

HelveLTMM STHeiti Light.ttf Chinese

Helvetica LT MM STHeiti Regular.ttf Chinese

Helvetica.dfont Symbol.dfont

Hiragino Kaku Gothic Pro W3.otf Japanese Times LT MM

Hiragino Kaku Gothic Pro W6.otf Japanese Times.dfont

Hiragino Kaku Gothic Std W8.otf Japanese TimesLTMM

Hiragino Maru Gothic Pro W4.otf Japanese ZapfDingbats.dfont
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APPENDIX C: THE “DO NOT REMOVE” FONT LIST

Table 22: Do Not Remove These Fonts

Font Location Reason

From Tiger: Absolutely Necessary

AquaKanaBold†

AquaKanaRegular†

Geneva

Helvetica*

Keyboard

LastResort

LucidaGrande

Monaco

/System/Library/Fonts The operating system
needs them.

Helvetica LT MM

Times LT MM

/System/Library/Fonts Preview uses them for
font rendering.

From Tiger: Recommended

Courier

Symbol

Zapf Dingbats

/System/Library/Fonts

Comic Sans

Georgia

Trebuchet

Times New Roman

Verdana

/Library/Fonts

Common Web and cross-
platform fonts.

From Adobe

All fonts in folder /Library/Application Support/
Adobe/PDFL/7.0/Fonts††

Acrobat needs them.

All fonts in folder /Library/Application Support/
Adobe/Fonts/Reqrd/Base

Adobe applications need
them.

* May be replaced by another version of Helvetica in any Fonts folder the system can access.

† May not be essential; anecdotal evidence indicates it is.

†† The number in the path may be different
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APPENDIX D: BINARY & HEXADECIMAL NUMBERING

You weren’t expecting anything on the third R—’rithmatic—in this
ebook, but Unicode uses hexadecimal references, as do several font
utilities, and it helps to know the basics.

The number system we use is base 10. It has 10 different digits (0-9),
and each “place” in a multi-digit number represents a power of 10,
which increases by one as you move to the left. A digit represents how
many of each power of 10 is included in the total. The number 256 is:

Decimal 256

Power 10^2 10^1 10^0

Value (100) (10) (1)

Digit 2 5 6

Totals 200 50 6

The computer is a binary animal, existing in a world of on/off, yes/no
circuits and decisions. A binary numbering system has two different
digits (0 and 1), and each place in a number represents a power of 2,
increasing by one as you move left. Decimal 281 is 100011001:

Decimal 281 = 100011001 binary

Power 2^8 2^7 2^6 2^5 2^4 2^3 2^2 2^1 2^0

Value (256) (128) (64) (32) (16) (8) (4) (2) (1)

Digit 1 0 0 0 1 1 0 0 1

Totals 256 0 0 0 16 8 0 0 1

Because it’s so difficult to read binary numbers (by the time you
reach 5000, you need a 13-digit string of 1’s and 0’s), humans who
commune deeply with computers use hexadecimal, or hex: base 16.
Following the rules for other bases, you use 16 different digits and
increase each place by powers of 16. Of course, there aren’t 16 dif-
ferent digits, so we substitute the letters A-F for the numbers 10-15.
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APPENDIX E: KEYBOARD CONTROL ON STEROIDS

System Preference settings give you choices regarding what you can
control from your keyboard. Several of the settings involve things that
can make font-related things easier:

• Focus on the Font panel: You have to specifically click on
the Font panel to “activate” it before you can use any keyboard
controls in it. That is, unless you know that pressing Control-F6
automatically moves the “focus” to a floating palette like the Font
panel. Oddly (and annoyingly), it doesn’t work as a toggle—using
the key combo again doesn’t shift the focus back to your applica-
tion window; use Control-F4 for that. These are the default set-
tings, which can be changed or turned off in the Keyboard
Shortcuts tab of the Keyboard & Mouse preference pane.

• Define the scope of the Tab key: By default, the Tab key
moves you to text boxes and lists in palettes and dialogs, but
you can include all the controls (buttons, sliders, pop-up menus,
and so on) in the tab sequence. Use Control-F7 to toggle between
the standard and the full tabbing capability, or toggle it in the
Keyboard & Mouse preference pane, at the bottom of the Keyboard
Shortcuts tab (Figure 61).

This setting changes the behavior of all your dialogs—even Open
and Save; this can be a good thing or drive you crazy when you
don’t want to tab to every little thing. But with Control-F7 acting
as an instant toggle, even after the dialog is open, there’s no reason
not to use it wherever you want.

FIGURE 61

The manual setting for Tab controls in the Keyboard & Mouse pane.
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APPENDIX F: USERS AND ACCOUNTS

If you’ve ignored the whole user account thing up until now and feel
practically illiterate when you run into Fonts folder pathnames, or
references to setting up a separate account to test your font problems,
relax: it’s simpler than you think.

Mac OS X is designed as a shared system, serving the needs—and
preserving the privacy—of more than one user, whether the users are
various employees or a few family members. If you’re the sole user,
you have to put up with some nonsense that’s a result of the shared-
Mac approach, with multiple places to store (and misplace) things,
folders that seem to have the same names, and the concept of having
an account on your Mac—an account with an administrator, who, in
all likelihood, is you. You run into the surface issue of this approach
every time you install software and you’re asked for an administrative
password (and doesn’t that make you feel important?).

For most practical purposes, you can think of a Mac as starting with
a single user account, a setup for a single user. Each user account has
an owner, the person who has a password to use it. At least one user
account has administrator privileges; the owner of an account with
these privileges is allowed to make systemwide changes on the Mac
that can affect all the accounts on it—like installing applications or
updating system software. The first user account that’s set up on your
Mac OS X machine automatically has administrator privileges. So,
if you’re the only user, you have an account with administrator
privileges. (You are the boss of you.)

The multi-user mindset of the operating system results in a hierarchy
of resources and privileges:

• System stuff: These are things the Mac needs to keep humming—
everything from starting up, to putting a dialog on the screen, to
opening an application when you double-click a document.

• Communal stuff: Things that every user account can access, like
applications, which are normally installed only once, in one place,
and shared by everyone.

• User stuff: Things that are private to each user, such as docu-
ments (obviously) and environmental things like the Desktop
background and preference settings.
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ABOUT THIS EBOOK

In contrast to traditional print books, Take Control ebooks offer
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